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tvOS at 6 Months: Where Are the Apps?
by Josh Centers

When Apple announced the fourth-generation Apple TV last September, I gave an audible (and 
embarrassing) “Whoop!” as I watched the presentation, eager to write the second edition of “Take 
Control of Apple TV” (which is now available). The little set-top box that could suddenly had a lot more 
potential, thanks to Apple finally adding an App Store (see “The Fourth-Generation Apple TV Is 
Coming at Last,” 9 September 2015).

But it has been nearly six months since the fourth-generation Apple TV was released, and there isn’t 
much to show yet. Yes, the tvOS App Store quickly added over 1000 apps, but growth since that initial 
explosion seems slow. I dutifully check the “Best New Apps” section every week, only to be disappointed 
by the slow trickle of interesting new apps.

The problem isn’t a complete lack of apps (there were over 2600 back in December, and likely many 
more than that now), but a dearth of those that make the Apple TV compelling (see “Apple TV App 
Store Growing Quickly… In the Wrong Direction?,” 11 December 2015). Just about every cable 
channel that offers a provider-activated streaming app has an entry in the tvOS App Store. But highly 
anticipated apps such as Amazon Video, Sling TV, and Spotify are nowhere to be found.

Probably the number one question I receive from readers of “Take Control of Apple TV, Second 
Edition” is: where is the Amazon Video app? In “Amazon Instant Video Coming to Apple TV” (30 
November 2015), we reported that Amazon had told engineer Dan Bostonweeks that it was indeed 
working on an Apple TV app, but it still hasn’t surfaced. I asked Amazon PR about the Apple TV app 
but never heard back.

It’s tough to say what exactly is going on with Amazon in regards to the Apple TV. Apple has openly 
stated that Amazon is more than welcome to develop for the Apple TV, and Amazon has apps in the 
iOS App Store, so I doubt the trouble is on Apple’s end. On the other hand, Amazon has been 
attempting to strong-arm Apple by banning the Apple TV from its online store (see “Amazon to Stop 
Selling Apple TV and Google’s Chromecast,” 2 October 2015). Amazon also purchased successful 
comic book retailer ComiXology, stripped in-app purchases out of the iOS app, and hasn’t done much 
with the company since (see “Explaining the ComiXology In-app Purchase Debacle,” 3 May 2014).

Since Amazon isn’t talking, and readers demand answers, I’m left to speculate. I figure the main issue is 
Apple’s refusal to let Amazon sell ebooks and other media via its apps without giving Apple a 30 percent 
cut. That’s also the conclusion of Steve Kovach at Tech Insider and Jeff Byrnes at AppAdvice. I bet 
that there is already an Amazon Video app for the Apple TV that Amazon is using as a bargaining chip 
while negotiating with Apple.

iOS is already a powerhouse platform, so Amazon doesn’t have much choice but to support it. But 
with a budding platform like tvOS, Amazon has a powerful negotiation tool with its popular Prime 
Instant Video service, in which it’s investing heavily.

As for other expected apps, I contacted Sling TV’s PR group to ask about an Apple TV app, but the 
only response I received was “We haven’t announced any new devices, but I’m happy to add you to our 
media list if you’re interested in keeping up to date on all Sling TV news.” Again, the absence of Sling TV 
is odd, since it’s available on Apple’s other devices. I contacted Spotify PR as well but never heard back. 
Spotify’s absence is even stranger than Sling’s, since Spotify is almost as ubiquitous as Netflix on streaming 
media devices. All I can think is that Spotify is unhappy about competing with Apple Music.
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SIG NEWS

The Saturday SMMUG Special Interest Group 
(SIG) will meet from 10:00 AM to 12:00 Noon, 
Saturday, June 11, 2016, in the Fire Station 18’s 
meeting room at: 6830 Hadler View (a map is 
located at the end of this NL). The meeting will be 
divided in to two parts.

The First part starting at 10:00 will focus on iOS, 
helping everyone become both comfortable and 
proficient with their iPhone, iPad, and iPod 
mobile devices. Starting at 11:00 we will focus on 
Photo Editing using Apple’s Photo program.

All are invited, but new users are especially 
encouraged to attend this free meeting. Bring your 
tips and tricks, questions and suggestions. 

For more information about Special Interest 
Groups (SIGs), go to the SMMUG website.

Scan this QR code to be taken to our 
SMMUG web site

ADVERTISING
You can advertise your business or service 
through the Silicon Summit.

RATES 
Per inch   $10
Quarter page   $15 
Half page   $25 
Full page   $50 
Insert                  $15

A 10% discount is applied for ads that 
run two or more months, except for 

inserts.

Sponsor ing Membersh ips a re a l so 
available to merchants who want to see 
their business name and address listed on 
the front page. Sponsoring Memberships 
are $100 for one year.

MEETING DATES
 

Our regular monthly meetings are on the FIRST 
Tuesday of every month. Upcoming meeting 
dates are as follows:

June 13, 2016
July 11, 2016

August 8, 2016
September 12, 2016
October 10, 2016

November 7, 2016*
December 12, 2016

*Meeting changed to the first week of Nov.

                                                                              

MISSED AN ISSUE?

You can find the previous issues of the 
Silicon Summit posted in PDF format at 
the SMMUG website.

THIS MONTH AT SMMUG

June 13, 2016
6:00 Q&A Session
6:45 Networking Break
7:00 Cutting the (TV) Cable by Jim 

Johnson (Part 1)
8:00 Adjourn

Silicon Summit is a monthly 
publication of the Silicon 
Mountain Macintosh User Group, 
Inc. 
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Announcements

June Presentation
SMMUG President Jim Johnson will 
deliver Part 1 of “Cutting the Cable” on 
Monday evening, 13 June. This two-part 
series will provide all the pros and cons of 
moving away from expensive, packaged 
entertainment services normally provided by 
Comcast, CenturyLink, Dish, and 
DirectTV. Available alternative options will 
be highlighted and discussed. 

Door Prizes For The June Meeting:
3 copies of Folx Pro (software)
Media Streaming Devices

Club News
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With large companies being close-mouthed, I decided to talk to independent developers to get their take on developing for Apple TV.
Developer Matt Braun emailed me first to tell me about the upcoming version of SketchParty TV. He had been working on SketchParty TV for 

the Apple TV years before the Apple TV even had an App Store, so I was keen to hear his take on how things were going. Unfortunately, it wasn’t 
all good news. He told me that after four years of meager returns on SketchParty TV, he nearly threw in the towel, deciding to carry on only after 
being invited to show off SketchParty TV at a private Apple event.

When I asked Braun if he had seen any improvement in sales since the release of the fourth-generation Apple TV, he replied, “I’ve definitely seen 
an uptick in sales, but my understanding is that I’m an exception. I think it’s because I’ve been building the SketchParty TV brand for so long that it 
has a small but growing fan base.”

I also asked developer Marco Arment if he’s planning to port his podcast player, Overcast, to the Apple TV (see “Overcast Refines the iPhone 
Podcast Experience,” 16 July 2014). He replied, “I’m not saying ‘never,’ but it’s not something I’m planning to work on in the near future. There 
just isn’t a lot of demand for an audio-only podcast player on such a young TV box yet. I’ve had far more requests for more audio-focused systems 
like Amazon Echo, Sonos, and Chromecast Audio than I’ve gotten for Apple TV to date, but I wouldn’t rule it out in the future if that changes.”

Of course, focusing an audio-based app toward audio-based systems is entirely sensible. And Overcast users can always AirPlay its audio to their 
Apple TVs, making a native app non-essential. But that’s still disappointing news for cheerleaders of the platform.

Overall, developer reaction to the new Apple TV was mixed. One developer who asked to remain anonymous said that porting to the Apple TV 
hadn’t been worth the time. However, Michael Krach of Deep Silver FISHLABS, developer of Galaxy on Fire — Manticore RISING (which I 
covered in “FunBITS: Testing the Siri Remote as a Game Controller,” 20 November 2015), said:

Manticore RISING plays like a charm and the eyeballs we got as a “day 1” supplier of a fledging platform were invaluable. The app remained in 
the paid charts of the Apple TV for weeks, and many reviewers named it a game that showed the huge potential that lay in the new hardware. On 
top, the buzz we got from the Manticore RISING release also had a positive impact on our other titles for iPhone and iPad. In the wake of 
Manticore RISING’s Apple TV release, they got increased visibility on the App Store and in the media as well.

It sounds like Manticore RISING was a big hit for Deep Silver FISHLABS, and Krach indicated interest in future Apple TV titles. But it’s 
important to note the level of promotion Manticore RISING enjoyed from Apple, both in Apple TV promotional materials and on the App Store. 
It was a hard game to miss!

Elsewhere, Apple TV gaming seems to be struggling. Disney recently announced that it’s already dropping support for its Apple TV version of 
Disney Infinity, saying in a forum post, “The team is currently focusing on the traditional gaming platforms. We are always evaluating and making 
changes, but there are currently no plans for further updates to the Apple TV version of the game.” That’s disturbing news for anyone who shelled 
out $99.95 for the Disney Infinity 3.0 Edition Starter Pack from the Apple Store, which is still on sale! Given that Apple also sells many of the 
accompanying Disney Infinity action figures, Disney’s abandonment of this app has to be a blow to the Apple TV team.

Even if an app you want arrives on the Apple TV, and stays around, there’s no guarantee that it will work. Take the recently released Starz app, 
which lets you watch Starz content in one of two ways: by activating with a participating cable provider or by subscribing directly from Starz for a 
monthly fee. Comcast is refusing to let the activation portion work with its TV service, angering many Comcast customers. Chris Welch of The 
Verge theorizes that Comcast is upset that the app combines both cable activation and a subscription service, unlike HBO and Showtime’s apps, 
which split those functions into separate apps. Either way, it’s a major annoyance for customers.

It’s not just the Starz app that has this problem. Comcast doesn’t support many cable-activated Apple TV apps, most notably those from AMC 
and Viacom, the latter including apps like Comedy Central, MTV, and VH1. But to be fair, this isn’t just an Apple TV problem. I can activate 
HBO GO on my Apple TV, but not my Fire TV or PlayStation 4.

A Murky Future for TV -- When he introduced the fourth-generation Apple TV, Tim Cook proclaimed that the future of TV is apps. That’s an 
entirely sensible position, but as we can see, political issues that weren’t present for the iPhone are hampering Cook’s predicted future.

So what are the factors holding back the Apple TV? Here are a few.
• A Weak Launch: I recently gave a presentation about the Apple TV for the Naples MacFriends User Group. The first question I received was 

about my initial impressions of the fourth-generation Apple TV, with a clear implication that members weren’t thrilled with the device out of the 
box.

And indeed, the fourth-generation Apple TV had a shaky launch. In addition to many bugs, it lacked features from the previous Apple TVs, 
such as Bluetooth keyboard support, the iOS Remote app, and Conference Room Display mode, and it was also missing obvious features like Siri 
search for apps and music, voice dictation, and iCloud Photo Library support. In addition to that, the App Store was unfinished, lacking basics 
such as Categories and Top Charts. It didn’t feel like a finished product until the release of tvOS 9.2 (see “With tvOS 9.2, the 
Fourth-Generation Apple TV Hits 1.0,” 23 March 2016).

After years of anticipation and rumors surrounding this device, the result felt strangely rushed, as if Apple had spent a long time on an entirely 
different vision and then cobbled together the final product at the last minute. First impressions matter, and I think the launch left a bad taste in 
people’s mouths.

Apple has addressed most of those issues now, but the Apple TV faces an uphill climb to overcome these early impressions.
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• A Poor Remote: The Siri Remote is flawed. It’s expensive, fragile, and worst of all, hard to hold. It’s 

way too symmetrical, making it clumsy to operate. I addressed these issues in “Wrangling the Siri 
Remote” (14 April 2016).

To be fair, the Siri Remote is being asked to do the impossible: be both a satisfying home theater 
remote and a competent gaming controller. Frankly, I don’t think that can be done.

Probably the best remote I’ve ever used is the one bundled with my current Vizio TV. It’s cheap 
plastic, but it’s comfortable, is just the right size, has just the right number of buttons, and even squeezes 
a keyboard on the back of the remote without making the entire contraption awkward. But it would 
make a terrible game controller!

Likewise, the PlayStation 4 controller is my all-time favorite game controller. Despite its funky look, 
it’s a vast improvement over its predecessors. It’s just the right size and weight, it fits my hand well, and 
the rear triggers stick out so they’re easy to wrap my fingers around. But those same triggers make 
controlling media a nightmare! It’s all too easy to bump the controller and send video into fast-forward 
mode. It doesn’t help that Sony’s button assignments are confusing and unintuitive.

The Apple way is to make one device that can do it all, but the enormous tradeoffs we see with the Siri 
Remote demonstrate the futility of that goal.

• Price: The new Apple TV is expensive. Granted, it’s not unusual for Apple to have the highest priced 
product in its class, but there’s usually a clear benefit for the user.

I would argue that the two big benefits of Apple TV are iTunes content and AirPlay, but both of 
those are available in the $69 third-generation Apple TV. Meanwhile, the fourth-generation Apple TV 
starts at $149. Will most users see a weak App Store as being worth the extra $80?

Plus, the Roku 4 is available for under $120, with more apps, support for 4K video, and voice search. 
Amazon’s current Fire TV is $99.99, and includes the superior Alexa voice assistant, 4K support, and 
most of the same apps and features as the Apple TV. For $139.99, you can get the Fire TV Gaming 
Edition, which includes a decent game controller, expanded storage, two excellent games (DuckTales: Remastered and Shovel Knight — see 
“FunBITS: Shovel Knight Digs Up the Fun” 13 December 2014), and a better game library.

I’m not even factoring in cheaper options, such as the Fire TV Stick, Chromecast, and various other editions of the Roku. Also, smart TVs have 
advanced steadily since we first published “Take Control of Apple TV.” The Netflix app on my Vizio TV is superior to the Apple TV version 
because it supports categories and 4K video.

Apple sat on its laurels too long, and that gave competitors a chance to catch up and surpass Apple in the living room. I initially gave the Fire TV 
a middling review (see “Amazon Fire TV Turns Up the Heat on Apple TV,” 2 April 2014), but it’s the box I would recommend today if you’re 
not already enmeshed in the iTunes ecosystem.

• Media Business Intrigue: Apple can redesign remotes, lower prices, and add features and polish, but the one thing it seems incapable of doing is 
going toe-to-toe with the TV-industrial complex.

It’s a forbidding system. The relationship among networks, advertisers, and content makers is a tangled web that’s only getting more 
complicated. Cable company Comcast now owns both NBCUniversal and DreamWorks Animation, making Comcast more powerful. 
Comcast’s dominant position can only make things harder for Apple in the future. If Apple angers Comcast, it could respond by pulling its vast 
library of content from iTunes. I’m sure this is one reason why Apple is investing in its own original programming, but it’s far behind the curve 
here — Netflix, Amazon, and Hulu are well ahead.

Having to activate seemingly every other video app with a cable provider is a usability nightmare. A unified panel for doing this would be helpful, 
or media companies could let one activation work for all apps from the same provider. Why should you have to activate A&E, History, and 
Lifetime separately, when they’re all owned by A&E Networks? If you sign in to one Google app on your iPhone, you’re automatically signed in to 
other Google apps. Single sign-on is a solved problem, but again, I suspect background politics are preventing a better solution.

Obviously, traditional media companies don’t have much incentive to aid the future of TV, and with things like data caps and activations, 
they’re doing all they can to slow it to a halt. As a result, it’s usually just easier, and often cheaper, to watch TV on your cable or satellite box.

• Developer Fatigue: Apple developers have had a lot to deal with in the past year. iOS 9 added new features like Split Screen and Picture in 
Picture, along with a bunch of behind-the-scenes changes. iPhones and iPads now come in several different sizes, each requiring a degree of 
optimization. On top of that, developers have to deal with the rapidly changing watchOS and tvOS, not to mention other platforms, like OS X, 
Android, Windows, and the Web.

For many developers, particularly smaller shops, it’s overwhelming. And it doesn’t help that developers don’t feel as though Apple has their best 
interests in mind. A common lament these days is that Apple promotes big developers while ignoring the little guys. To make matters worse, 
Apple’s policies have pushed app pricing down to unsustainable levels. There just isn’t much money in the App Store anymore, particularly for 
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smaller developers. And if you do produce a successful app, there’s no guarantee that Apple won’t copy your concept outright or kick you out of 
the App Store for no apparent reason (see “iOS 8 App Development Becomes a “Bring Me a Rock” Game,” 15 December 2014). Or, worst of 
all, Apple keeps you off its platform and then implements your idea, like it did with f.lux (see “iOS 9.3 Works the Night Shift, Protects Notes, 
and More,” 21 March 2016)? You might even sell hundreds of copies of an app, only to have those sales refunded years later. To add insult to 
injury, developers might have to compete with other media in the App Store itself! Developer enthusiasm is at a new low, and what once felt 
like a gold rush now seems more like post-1960s San Francisco.
That’s if you’re a small fish. If you’re a big developer, you have to worry about Apple competing with your core business! Why should Spotify help 

boost the new Apple TV with an app when Apple is hoping to drive them out of business with Apple Music? If you’re a content provider, why 
support the Apple TV, when Apple is likely going to compete against you soon? If you’re a cable company, why help Apple replace your precious 
1980s-vintage cable boxes? (Though the FCC may not give you much choice.)

I’m afraid the fourth-generation Apple TV has entered the dreaded “chicken or egg” zone, something I’ve seen countless times with living room 
devices, mainly video game consoles. Software moves hardware, and if the apps aren’t there, people won’t buy the boxes. And if hardware sales are 
slow, developers won’t build software for the platform. It’s a vicious cycle, but I think Apple is better equipped to break free of it than most.

Developers, Developers, Developers! -- The tech community had a good laugh at former Microsoft CEO Steve Ballmer’s chant of 
“DEVELOPERS, DEVELOPERS, DEVELOPERS,” but he was right! A platform is nothing unless developers are making interesting apps for it. 
Unfortunately, while he identified the issue, it was Apple that was better able to attract those developers.

But Apple has taken those developers for granted, punishing them with vague and onerous rules, devaluing their work, complicating the product 
lineup, and even taking over their ideas.

Most trace Apple’s current stature back to the launch of the iPhone, but I would point rather to the now-famous slogan, “There’s an app for 
that” that debuted with the iPhone 3G. Sure, some Apple die-hards wanted the iPhone for the innovative touch screen and other technologies, but 
what convinced the masses to drop serious coin on iPhones and data plans was the universe of apps inside the App Store. Ultimately, it’s third-party 
developers that make or break a platform.

I would go so far as to blame many of Apple’s current woes on deflated and depressed developers. The once-promising Mac App Store is now a 
wasteland thanks to Apple’s overbearing requirements, such as sandboxing, which is unworkable for many popular apps. If the Apple Watch is 
indeed a dud, it’s because it has few interesting apps to sell the platform. If people are bored with their iPhones and iPads, it’s because the 
once-endless stream of exciting new apps has slowed to a trickle.

That brings me back to the Apple TV. If developers were producing killer apps for it, it would sell, regardless of the price, the weird remote, and 
whether or not big companies wanted to play along. And after a certain point, those companies wouldn’t have a choice but to support the Apple 
TV. But we’re not even seeing improvements to those apps I found most compelling early on (see “Apps that Reveal the Apple TV’s Potential,” 9 
November 2015). Why don’t Zillow and Airbnb let you pan around a map of locations (a capability introduced in tvOS 9.2), and why can’t the 
Fidelity app let you customize its widgets? Are these apps moribund?

With Apple’s revenue dropping for the first time in well over a decade (see “In Q2 2016, Apple Sees First Revenue Decline in 13 Years,” 26 
April 2016), we’re seeing an 
endless stream of pundits 
offering advice for the 
company. But rather than 
build cars, ship cheaper 
iPhones, or give more money 
to shareholders, my simple 
advice would be to announce 
App Store policy changes at this 
year’s Worldwide Developer 
Conference to reinvigorate the 
developer community. If 
developers saw Apple as a 
partner facilitating their 
business goals, rather than as a 
dour gatekeeper, we might see a 
flowering of apps for all of 
Apple’s platforms, including 
the Apple TV. And that, in 
turn, would get Apple’s 
customers excited again.
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Can’t wait for the next newsletter to see what the guys and gals at Joy of Tech are up to? Then simply go on over to their 
website and see past and current cartoons and other things

http://www.joyoftech.com/joyoftech/
http://www.joyoftech.com/joyoftech/
http://www.joyoftech.com/joyoftech/
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DOOR PRIZE WINNERS

For The June 2016 Meeting
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iPhone & iPad 
The iPhone SE: A Modern iPhone in a Classic Case

by Julio Ojeda-Zapata
I used to be a small-phone guy, insistent that I would never wield a “phablet” – an awful-sounding term for what I then thought was an equally 

dreadful form factor. Who would want a phone you can’t use with one hand?
But when Apple released the iPhone 6 Plus two years ago (see “Apple Announces iPhone 6 and iPhone 6 Plus with Larger Screens,” 9 

September 2014), I had a change of heart. I was seduced by the 5.5-inch iPhone with its gorgeous and ginormous screen perfectly suited for reading 
books, watching videos, and editing photos in a non-claustrophobic fashion.

I got rid of my 4-inch iPhone 5s and all my accessories tailored to that form factor and consigned this petite product category to tech history.
Now, to my mild consternation, it’s back.
Two months ago, Apple introduced the iPhone SE (see “Apple’s March 

Event Reflects Increased Customer Responsiveness,” 21 March 2016), a 
model that is externally all but identical to the iPhone 5 and 5s, but has 
internal components like the A9 processor that are more akin to the iPhone 
6s and 6s Plus. It’s a modern iPhone with a classic look, and one that 
happens to be compatible with all those iPhone 5s accessories I now regret 
discarding.

To my surprise, I liked the iPhone SE. Slipping it into the front pocket of 
my jeans, I felt relieved that I didn’t have to struggle to shoehorn a massive 
iPhone 6s Plus into that tight space. For all my love of the iPhone 6s Plus’s 
expansive screen, a burden had been lifted.

Small iPhone, Big Market -- I’m hardly alone in enjoying the feel of a 
smaller iPhone.

Apple CEO Tim Cook said earlier this year that about 60 percent of iPhone users who had purchased models predating the iPhone 6 had not 
upgraded to a large-screen flavor. What’s more, Apple said it sold 30 million 4-inch iPhone models in 2015 alone, a sign of enduring demand for 
smaller iPhone versions.

Apple hasn’t yet revealed how well the iPhone SE is selling, but I’m betting it’s doing better than the iPhone 5c did. That 2013 model, positioned 
as “unapologetically plastic” with a nonstandard form factor and outdated internals, is now regarded as something of a blunder.

With the iPhone SE, Apple appears to have learned from its errors. Those investing in a small-size iPhone are no longer forced to make profound 
sacrifices in gadget construction, features, and horsepower. Though the iPhone SE is not 100 percent equivalent to the iPhone 6s and 6s Plus, it’s 
close. While carrying an iPhone SE review unit around for two months, I seldom felt I was making significant compromises.

As an avid iPhone photographer, I produced photos that are indistinguishable in quality from those I’ve shot with my iPhone 6s Plus. Features like 
Live Photos, 4K capture, slo-mo, time-lapse video with stabilization, and Retina Flash are all on board. What’s more, the smaller iPhone SE is a more 
manageable chassis for its glorious 12-megapixel sensor.

I adore the classic design with its chamfered edges, now matte instead of shiny. 
Those flat sides allow the gadget to be balanced vertically on a table, and the 
small size and shape lends the iPhone SE to single-handed use.

And the iPhone SE’s lower cost is a major plus. It starts at just $399 for a 16 
GB model, compared to an iPhone 6s at $649.

Just a Few Sacrifices -- Apple has a long history of staggering its devices’ 
feature sets to save some good stuff for top tiers while mildly short-changing 
those in the lesser echelons.

The iPhone SE is no exception. This is a top-flight iPhone, to be sure, though 
it does lack some features. But how much will you miss these features?

3D Touch: The iPhone SE has only a vibration motor and not the more advanced Taptic Engine necessary for 3D Touch feedback. But few 
apps have implemented 3D Touch peeking and popping properly. 
I rarely used 3D Touch on the iPhone 6s Plus, and even in those apps that support it, like the Twitter client Tweetbot, I didn’t miss 3D Touch 
when using the iPhone SE.

http://tidbits.com/article/15058
http://tidbits.com/article/15058
http://www.apple.com/iphone-se/
http://www.apple.com/iphone-se/
http://tidbits.com/article/16353
http://tidbits.com/article/16353
http://tidbits.com/article/16353
http://tidbits.com/article/16353
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128 GB capacity: Apple offers this storage level for the iPhone 6s and iPhone 6s Plus, but the iPhone SE tops out at 64 GB. That can hurt a bit, 

but it’s increasingly easy to store content in cloud-based services like iCloud Photo Library and Google Photos.
For instance, every picture I shoot gets automatically pushed to my Google Photos account, and my Google Photos app can purge local pictures that 
have been backed up online. So, local storage isn’t as important as it once was.

Optical image stabilization: Though the iPhone SE shoots 4K video just like its big brothers, it lacks a feature called optical image stabilization to 
steady video that would otherwise appear jerky. Only the iPhone 6s Plus provides such stabilization (as well as the previous iPhone 6 Plus).
This lack makes the iPhone SE a bit problematic for me since, as a journalist, I use a phone as a camera in a professional capacity. I can work around 
the issue with a monopod or tripod, though. Average users who don’t shoot much video might not miss optical image stabilization.

Front-facing camera: While the iPhone 6s and iPhone 6s Plus boast a 5-megapixel front-facing camera, the iPhone SE’s camera offers only 1.2 
megapixels. That’s an odd reduction, but of concern only to those who take a lot of selfies or who do a lot of FaceTime calls or videoconferencing.
Personally, I think selfies are silly. However, for selfie fanatics, this deficiency could be a deal-breaker.

Older Touch ID sensor: Not every iPhone Touch ID sensor is created equal. The iPhone 6s and 6s Plus boast a faster second-generation sensor, 
but the first-generation version found on the iPhone SE is the slower one on the iPhone 5s.
Faster logins and authentications are great, but the slower sensor on the iPhone SE wasn’t crippling during my time with the device.

Display Zoom and Reachability Mode: These screen features, absent from the iPhone SE, are included with the iPhone 6s and 6s Plus to help 
users cope with bigger displays. A too-large screen isn’t an issue on iPhone SE, so there’s no reason to include these capabilities.

No LTE Advanced: Some tablets and phones with cellular capabilities have zippier Internet access than others. This is due to LTE Advanced, 
found only in the iPhone 6s and 6s Plus and the new 9.7-inch iPad Pro, that boosts data rates and theoretical throughput. LTE Advanced makes a 
real difference where it’s supported, with downloads that are often twice as fast.
The iPhone SE lacks LTE Advanced, which is a bummer. But the feature is more critical to me on a tablet, which I would use more heavily for 
productivity, than on a phone.

Obscure omissions: The iPhone SE doesn’t have a barometer, which would let it determine altitude as well as elevation changes. That’s not 
something I care about, but it could be important to athletes and outdoor enthusiasts.
The iPhone SE also lacks “dual-domain pixels,” which improve viewing angles, along with the higher contrast ratios, greater water resistance, and 
harder aluminum found in the iPhone 6s and 6s Plus. I haven’t noticed the differences, and I doubt most others will either.

Taking stock of all these omissions, I am hard-pressed to identify one so significant as to decisively negate the allure of a small iPhone. Of course, 
everyone has different needs. But, on balance, I think Apple has done a good job of producing a smaller iPhone that is competitive with its larger 
siblings and therefore appealing to a wide range of possible purchasers. In other words, the iPhone SE is a winner.

My Big, Final Decision -- After several weeks of iPhone SE use, it was time to return to my iPhone 6S Plus. Would I be dismayed? Relieved?
A little of both, as it turned out.
I missed being able to move about easily with a phone in my front jeans pocket, something that’s difficult to do with the iPhone 6s Plus – 

especially for me, a pint-sized Puerto Rican, with jeans whose pockets aren’t much deeper than those in women’s jeans. But I easily reverted to my 
old habit of slipping the iPhone 6s Plus into my back pocket, a position that has worked fine for the last two years.

It’s impossible to have the iPhone 6s Plus in my front pocket while I’m sitting down, something that isn’t a problem with the iPhone SE, but this 
for me is a hypothetical scenario. Typically, my phone comes out as my butt goes down.

I also mildly missed using the iPhone SE one-handed with thumb gestures, but I’m highly adaptable and don’t mind using a larger smartphone as 
I would an iPad – holding it with my left hand while jabbing at it with my right index finger. At least in my case, scenarios requiring one-hand phone 
use rarely come up.

While adapting to the iPhone SE’s smaller screen during my test run didn’t cause me all that much pain, returning to the iPhone 6s Plus’s big 
screen was a relief in some ways. Display real estate matters for a whole bunch of reasons.

I sometimes use my iPhone to work, at times paired with a wireless keyboard (see “Physical Keyboards for the iPhone 6 Plus,” 25 Oct 2014). 
While I don’t do this as often as I would on an iPad, it happens frequently enough that a cramped display can sap my productivity.

A smaller screen also is a hindrance in photo work. A bigger viewfinder is always better, and the size of the display becomes even more important 
when triaging and editing photos. I do more photo processing on mobile devices than I do on a desktop Mac, so the iPhone SE’s tiny display doesn’t 
cut it for me.

During moments of relaxation, a larger screen is welcome for reading ebooks and watching videos. Though this is doable on the iPhone SE, I 
found it too cramped to be truly enjoyable.

Prospective iPhone SE buyers have to ask a few hard questions before plunking down their money.
If scoring a smaller and lighter smartphone is of paramount concern, the iPhone SE might be the right way to go, despite its omissions. While not 

the equal of its siblings in every way, it’s a darn good iPhone.
But people who spend a lot of time on an iPhone, whether for work or pleasure, may want to think about whether the iPhone SE’s smaller screen 

would be too limiting. For those who regard their handsets as productivity or entertainment hubs, a larger screen may be necessary to avoid eyestrain 

http://www.anandtech.com/show/8509/understanding-dual-domain-pixels-in-the-iphone-6-and-iphone-6-plus
http://www.anandtech.com/show/8509/understanding-dual-domain-pixels-in-the-iphone-6-and-iphone-6-plus
http://tidbits.com/article/15148
http://tidbits.com/article/15148
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or digital claustrophobia.

I’ve concluded that I’m definitely in the latter camp, with an affinity for a large display to ease a range of hardcore activities.
But for those who prefer a powerful iPhone that fits better in a pocket or in one hand, the iPhone SE is perfect, and I’m betting it will prove a 

popular option.

Apple Reissues iOS 9.3.2 for the 9.7-inch iPad Pro
by Josh Centers

After releasing iOS 9.3.2 several weeks ago (see “Apple Releases OS X 10.11.5, iOS 9.3.2, tvOS 9.2.1, and watchOS 2.2.1,” 16 May 2016), 
Apple quickly pulled the update for the 9.7-inch iPad Pro because it left some units unusable (see “Apple Pulls iOS 9.3.2 for 9.7-inch iPad Pro,” 
20 May 2016).

Apple has now reissued iOS 9.3.2 for the 9.7-inch iPad Pro, so it should be safe to update now. Devices already running iOS 9.3.2, including 
9.7-inch iPad Pro models that updated successfully, don’t need to update again. But if you were appropriately cautious and held off updating, you 
can now do so in Settings > General > Software Update or via iTunes on your Mac. The update also reportedly fixes iPads bricked by the last 
update.

As we reported previously, the iOS 9.3.2 update is relatively minor, including only a handful of bug fixes and security improvements.

Apple Releases OS X 10.11.5, iOS 9.3.2, tvOS 9.2.1, and watchOS 2.2.1
by Josh Centers

Apple has updated all of its operating systems with bug fixes and security improvements, but no new features. To see detailed security notes on all 
of these releases, check the Apple Security Updates page. Unsurprisingly, given all the code shared among the different operating systems, many of 
the security fixes are shared as well.

Although we haven’t yet heard of any problems, we recommend holding off on these updates for a week or so until the early adopters have had a 
chance to report back about unexpected issues. Assuming that nothing major rears its ugly head, you will want to install these updates shortly after 
that, though, since all those security fixes are important for maintaining herd immunity from malware.

OS X 10.11.5 -- The release notes for the latest version of El Capitan are utterly vague: “The OS X El Capitan 10.11.5 update improves the 
stability, compatibility, and security of your Mac, and is recommended for all El Capitan users.” The update also provides a couple of enterprise 
fixes that should make administrators happy. Currently, you can get the OS X 10.11.5 update (758 MB) only via Software Update, though we 
expect standalone downloads to appear soon on Apple’s Support Downloads page.

iOS 9.3.2 -- Happily, iOS 9.3.2’s release notes are a bit more descriptive than those for OS X 10.11.5. Nonetheless, after the major iOS 9.3 (see 
“iOS 9.3 Works the Night Shift, Protects Notes, and More,” 21 March 2016), this one is just bug fixes. Apple claims that iOS 9.3.2 addresses 
Bluetooth audio quality issues on the iPhone SE, an issue where looking up dictionary definitions could fail, a problem that prevented typing email 
addresses with the Japanese Kana keyboard in Mail and Messages, an issue with the Alex VoiceOver voice that caused it to try on a different accent 
when speaking punctuation or spaces, and a bug that prevented MDM (mobile device management) servers from installing custom B2B apps. You 
can obtain the iOS 9.3.2 update via Settings > General > Software Update or iTunes. On an iPhone 6, the over-the-air update was 89.4 MB.

tvOS 9.2.1 -- Apple added a lot of new features in tvOS 9.2 (see “With tvOS 9.2, the Fourth-Generation Apple TV Hits 1.0,” 23 March 
2016), but the tvOS 9.2.1 update seems to focus exclusively on bug fixes and performance improvements. We can’t say for sure because Apple 
doesn’t publish tvOS release notes. If you’re not offered the update automatically, you can get it by going to Settings > System > Software Updates > 
Update Software.

watchOS 2.2.1 -- Finally, Apple has updated watchOS to 2.2.1, which “contains bug fixes and security updates.” The 26.9 MB update can be 
found in the Watch app on your iPhone, in My Watch > General > Software Update. To update, the Apple Watch needs to be in range of your 
iPhone, connected to its charger, and charged to at least 50 percent. The entire process could take 30–45 minutes all told, so make sure you have 
time.

Mac OS, iOS , tvOS & WatchOS

http://tidbits.com/article/16500
http://tidbits.com/article/16500
http://tidbits.com/article/16516
http://tidbits.com/article/16516
https://support.apple.com/en-us/HT201222
https://support.apple.com/en-us/HT201222
https://support.apple.com/en-us/HT206230
https://support.apple.com/en-us/HT206230
https://support.apple.com/en-us/HT206230
https://support.apple.com/en-us/HT206230
https://support.apple.com/downloads/
https://support.apple.com/downloads/
http://tidbits.com/article/16329
http://tidbits.com/article/16329
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Bob “Dr. Mac” LeVitus’ Tips
I feel like I’ve been on the road more than I’ve been home lately. Since returning from Germany at the end of April (you can read all about that 

trip at The Mac Observer: The Internet of Things is Really a Thing in Germany), I have traveled to Denver and Colorado Springs to visit my 
daughter and the Silicon Mountain Macintosh User Group respectively. Then, last week, we drove to Lawrence, KS to watch my son graduate 
from the University of Kansas.

And that, gentle reader, is why it’s been several weeks since my last missive. I'm sorry for the delay but I’m back now, and better than ever. Want 
proof? Here's a killer tip on saving time and effort with proxy icons.

Proxy Icons Rock!
If you don’t know what a proxy icon is, or you know what it is but didn’t know it was called a “proxy icon,” I'm talking about the little icon in the 

title bar of all Finder windows and most document windows, like these: 

It’s important to note that while Finder windows always display a proxy icon, you can’t use them in document windows until the file has been 
saved. Furthermore, the proxy icon will be dimmed as long as there are unsaved changes to the document.

How do you know if there are unsaved changes? Files that need saving have a black dot in the middle of their red Close buttons and their proxy 
icons are dimmed and un-selectable; saved files have no black dot and their proxy icons are normal—undimmed and selectable—as shown here: 

Now that you know what proxy icons are, here are seven cool ways they can save you time and effort:
1. Move the file or folder to a new location by dragging its proxy icon to a different folder, disk, or to the Trash.
2. Make a copy of a file or folder by pressing the Option key and dragging the proxy icon. 
3. Make an alias of a file or folder by pressing the Command and Option keys and dragging the proxy icon.
4. Add the file or folder to the Toolbar of all Finder windows by pressing the Command and Option keys while dragging the proxy icon onto the 

Left to right: Photoshop, Word, and Finder windows with their proxy icons highlighted.

Unsaved documents have dimmed proxy icons and black dots in their red Close buttons.

http://(http://www.macobserver.com/tmo/article/the-internet-of-things-is-really-a-thing-in-germany
http://(http://www.macobserver.com/tmo/article/the-internet-of-things-is-really-a-thing-in-germany
http://www.smmug.org/
http://www.smmug.org/
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Toolbar. 
Tip: To remove an icon from the Toolbar, press the Command key and drag it off the Toolbar—it will disappear with a satisfying “poof.”

5. Add the file or folder to the Sidebar of all Finder windows by dragging the proxy icon onto the Sidebar. 
Tip: To remove an item from the Sidebar, drag the item off the Sidebar until you see a little X, then, release the mouse button and watch it 
disappear with a satisfying “poof.”

6. Drag a folder's proxy icon onto any Open File dialog or Save sheet to display that folder's contents in the Open File dialog or Save sheet. 
7. Right-click the proxy icon (or click while pressing either the Command or Control key) to see the path to the document or folder (Smart Proxy 

icon tricks in the figure below).
 If you release the button while a folder along the displayed path is selected (Dropbox in the figure below), its Finder window will open.

That's nice, but if you select one of the other  folders  (Dropbox above) before releasing the mouse or trackpad button,  that 
folder's contents will appear in a new Finder window or tab, which is even nicer. 

I use proxy icons almost every day and they save me time and effort every time I do. If you're already a proxy icon user, congrats on knowing this 
elegant technique for moving, copying, creating aliases, and more. If this is the first time you've considered proxy icons, try to remember them the 
next time you need to move, copy, create an alias, or whatever.  
     

Gifts and More Gifts
Since last we spoke, I've written not one but two Gifts for Dads & Grads columns for The Mac Observer. 
Episode #174, The Never-ending Story: Gifts for Dads & Grads 2016 (Part I) is chock full of stuff I think will put a big smile on the face of 

your dad or grad (as long as your dad or grad is a geeky music lover like me…)
Episode #175: The Never-ending Story: Gifts for Dads & Grads 2016 (Part II) is about subscriptions and gift cards, which  I used to 

eschew, but now realize they make great gifts for certain dads & grads (and you know who they are...). 
That's all I've got for you this time but rest assured I'll be back Real Soon Now™. So, stay tuned!

Yours Truly,

Reprinted with Bob LeVitus’ permission. Sign up for the Working Smarter for Mac Users NL to get Bob’s tips delivered directly to your email box.

Right-click, Command-click, or Control-click the proxy icon to see the path to this 
document or folder (Smart Proxy icon tricks).

http://www.macobserver.com/tmo/article/the-never-ending-story-gifts-for-dads-grads-2016-part-i
http://www.macobserver.com/tmo/article/the-never-ending-story-gifts-for-dads-grads-2016-part-i
http://www.macobserver.com/tmo/article/the-never-ending-story-gifts-for-dads-grads-2016-part-ii
http://www.macobserver.com/tmo/article/the-never-ending-story-gifts-for-dads-grads-2016-part-ii
http://www.workingsmarterformacusers.com/signupform
http://www.workingsmarterformacusers.com/signupform
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Netflix Adds 600 Kbps Preset Throttle to Mobile Apps
by Glenn Fleishman 

Streaming video can quickly consume large amounts of data on modern 4G LTE networks, which rival or exceed most home DSL throughput. 
Netflix has made a change to its mobile apps for iOS and Android to throttle streaming 
rates to 600 Kbps over cellular networks. But you can change it.

This update comes in response to Netflix admitting in March 2016 that it was 
throttling users to the same rate on AT&T, Verizon, and other cellular networks around 
the world, and had been doing so for over five years. At the time, Netflix said that 
throttling was to “protect consumers from exceeding mobile data caps.” (Netflix didn’t 
throttle on T-Mobile and Sprint, which slow most customers’ connections down to a 
relative crawl instead of charging overages.)

iOS has a lot of cellular data controls that let you choose which kinds of activities, and 
even which apps, may use data on mobile networks. That’s one way to approach it, 

though the controls are 
typically coarse: an app either 
can use cellular or not.
Some people who have flipped 
a lot of those mobile data 
switches to the Off position 
were taken aback by overage 
bills because of iOS 9’s Wi-Fi 
Assist feature, which switches 
back and forth to cellular when 
you’re using flaky Wi-Fi. 
When Wi-Fi Assist is engaged, 
iOS isn’t supposed to use data 
for background apps, email attachments, or third-party streaming audio or video — but 
it’s not clear that iOS honors that setting all the time. (You can disable Wi-Fi Assist in 
Settings > Cellular 
below what can be a 

long list of cellular-capable apps, where iOS also displays the amount of data 
you’ve used since the last time you reset cellular usage statistics.)

Netflix’s intentions were good. Although it does cost the company something 
to stream more data to you, that amount is tiny compared to the expense of the 
licensing rights to the media you’re watching. Netflix is more concerned about 
keeping you as a subscriber, rather than you canceling out of anger when you get 
an excessive bill for which the Netflix app gets fingered. But Netflix should have 
disclosed this earlier and provided the kind of control it now offers in its apps.

I like the data-unit terms in which Netflix puts the change. It notes in its blog 
post that at 600 Kbps, your device will transfer about 1 GB of data for about 3 hours of movies or TV programs. Or, conversely, about 300 MB per 
hour watched.

Netflix has turned this option on by default in the new app version released 4 May 2016. You can find the option in the app by tapping the menu 
button, and swiping down to find and tap App Settings. Cellular Data Usage is the only setting shown in App Settings at the moment in iOS.

The option reduces quality by some amount over unthrottled mobile viewing, but how much of that can the average iPhone or iPad viewer 
perceive? It’s hard to tell, because an action movie may show motion or color-field artifacts more readily, but it depends on lighting conditions and 
how far you’re holding or propping up your device from your eyes, as well as your visual acuity.

The Internet

https://media.netflix.com/en/company-blog/netflix-introduces-new-cellular-data-controls-globally
https://media.netflix.com/en/company-blog/netflix-introduces-new-cellular-data-controls-globally
https://media.netflix.com/en/company-blog/netflix-introduces-new-cellular-data-controls-globally
https://media.netflix.com/en/company-blog/netflix-introduces-new-cellular-data-controls-globally
http://www.wsj.com/articles/netflix-throttles-its-videos-on-at-t-verizon-phones-1458857424
http://www.wsj.com/articles/netflix-throttles-its-videos-on-at-t-verizon-phones-1458857424
http://www.macworld.com/article/3018525/iphone-ipad/how-to-avoid-a-surprising-bill-due-to-wi-fi-assist.html
http://www.macworld.com/article/3018525/iphone-ipad/how-to-avoid-a-surprising-bill-due-to-wi-fi-assist.html
http://www.macworld.com/article/3018525/iphone-ipad/how-to-avoid-a-surprising-bill-due-to-wi-fi-assist.html
http://www.macworld.com/article/3018525/iphone-ipad/how-to-avoid-a-surprising-bill-due-to-wi-fi-assist.html
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Some carriers offer unlimited data plans, notably T-Mobile, in which case you might tap Set Automatically to turn the setting off and then pick 

Unlimited. T-Mobile, by the way, has its own data optimization approach called Binge On, which it enables by default on every service plan, 
including unlimited plans. T-Mobile degrades streaming video but doesn’t count it against your data usage if you have a metered plan. It’s not clear 
how Netflix’s throttle and Binge On will interact in affecting video quality. (Binge On can be disabled.)

Cellular Data Usage has four options besides Set Automatically and Unlimited. The Off (Wi-Fi Only) setting prevents the app from using mobile 
data, no matter how you’ve configured the iOS setting for the app. Or you can pick Low, Medium, or High, which correspond to what Netflix 
reports as consuming 1 GB in 4, 2, or 1 hours (250 MB, 500 MB, and 1 GB per hour). That data usage corresponds to rates of roughly 500 Kbps, 
1 Mbps, and 2 Mbps. Netflix’s help document on data usage shows its top rate for standard definition (SD or 480p) quality is 3 Mbps and, for 
HD (1080p), 5 Mbps.

In December 2015, the company told Variety that it was about to re-encode its videos with different levels of compression depending on the 
video’s content. It said that “My Little Pony” takes about 1.5 Mbps for HD, and it shrunk its in-house show, “Orange Is the New Black” from 5.8 
Mbps to 4.6 Mbps without a loss in quality. That means that, with the same throughput, you can get a more detailed, less blurry stream. Streaming 
services including Netflix are always looking for improvements like this, and new video-encoding algorithms could reduce data rates even further.

If you’re not on an unlimited plan, I recommend sticking with Set Automatically. It’s exactly what you’ve gotten for as long as you’ve used a 
Netflix mobile app, so unless you dislike that quality and want an improvement, there’s no reason to change. And in the weeks and months to come, 
it might just improve without you doing a thing.

Twitter to Loosen Its 140-Character Limit
by Josh Centers 

Every social network stands out in some way, and Twitter’s defining feature has been its strict 140-character limit, a byproduct of the service’s 
SMS-based origins. That enforced brevity helps keep conversations concise and your timeline hopping. On the downside, it’s challenging to 
compose thoughtful messages in so little space, leading to confusion, misunderstanding, excessive use of abbreviations, and worse.

It’s thus big news that Twitter will soon loosen the 140-character restriction, if only slightly.
Over the next few months, Twitter will stop counting various standard bits of text in the character limit. Links to media attachments, such as 

photos, polls, and videos, as well as @names in replies, will no longer count against the character limit. That should relieve a little of the pressure 
when composing posts.

Twitter users will also experience another important change when using @names. As it stands now, if you begin a tweet with an @name, that 
tweet enters the timelines of only those people who follow both you and the person you’re mentioning. The idea was that you were either addressing 
that person directly or replying to them, so the tweet shouldn’t be public. Many people, at least those who understood it, disliked the effect and 
circumvented the policy by prefixing tweets that should both be public and mention someone with a period, like so:

.@glennf is working on a book about Slack!
When this change goes into place, new tweets starting with an @name will be seen by all of your followers. However, the change won’t apply to 

replies, so if you reply to a tweet and maintain a conversation, it will still be visible only to your followers and their followers. This nuance also means 
that if you follow an account that replies regularly, like @AppleSupport, your timeline won’t be flooded with unwanted messages.

Finally, Twitter plans to let you retweet and quote your own tweets, so you can repost tweets overlooked by followers who weren’t hanging on 
your every word. You’ll also be able to retweet your replies that begin with @name if you want all of your followers to see them.

These changes are long overdue and should make it easier to have discussions on Twitter. Unfortunately, the changes may not help Twitter’s 
financial outlook much: after Twitter revealed the new tweaks, Twitter analyst Michael Nathanson downgraded Twitter’s stock rating to “sell,” 
saying, “Hope is not a strategy.” Ouch.

TuneIn to Radio Stations Worldwide, Plus Sports and Audiobooks
by Josh Centers

In this age of digital communication, old-fashioned terrestrial radio is still relevant for music, news, sports, and talk. Algorithmic radio alternatives 
like Pandora are no help when you want local weather warnings, and podcasts aren’t useful when you want live election results or sports scores.

Radio has a lot of advantages: it’s free, local, live, and simple. But it also has a lot of drawbacks. AM/FM radios aren’t as commonplace as they once 
were, and for many of us can be found only in our cars. Even if you have a radio in your living room or at your desk, it can be hard to get a strong 
signal from your desired station. And the local aspect is a double-edged sword, as not all programs are available in all markets — try finding a 
Chicago Cubs game to listen to in the Nashville broadcast area!

The Internet service TuneIn solves these problems by bringing live radio to your Web browser or iOS device via the free TuneIn Radio app (it’s 
also available in various smart TVs and media-streaming boxes from companies like Roku, and it’s even built into over 55 vehicles). TuneIn isn’t the 
first company to do this, but a few things set it apart from the alternatives: the interface is straightforward and clean, there’s no pressure to sign up for 
an account or hand over personal information, and it integrates sources outside of traditional radio, like computer-generated music stations and 

https://support.t-mobile.com/docs/DOC-24294
https://support.t-mobile.com/docs/DOC-24294
https://help.netflix.com/en/node/306
https://help.netflix.com/en/node/306
http://variety.com/2015/digital/news/netflix-better-streaming-quality-1201661116/
http://variety.com/2015/digital/news/netflix-better-streaming-quality-1201661116/
https://blog.twitter.com/express-even-more-in-140-characters
https://blog.twitter.com/express-even-more-in-140-characters
https://twitter.com/AppleSupport
https://twitter.com/AppleSupport
http://www.billboard.com/articles/business/7385177/twitter-analyst-downgrades-stock-to-sell-says-hope-is-not-a-strategy
http://www.billboard.com/articles/business/7385177/twitter-analyst-downgrades-stock-to-sell-says-hope-is-not-a-strategy
http://tunein.com/
http://tunein.com/
https://itunes.apple.com/us/app/tunein-radio-stream-live-radio/id418987775?mt=8&at=10l5PW
https://itunes.apple.com/us/app/tunein-radio-stream-live-radio/id418987775?mt=8&at=10l5PW
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podcasts. TuneIn is used by a reported 60 million people worldwide, and it boasts access to 100,000 live radio stations and 4 million on-demand 
programs.

A search box is the most prominent feature on TuneIn’s 
home page. If you know exactly what you’re looking for, 
the search field makes it easy to enter a station’s call sign 
(“WBUZ”), a genre (“bluegrass”), or a show name 
(“Acoustic Cafe”). You can also search more broadly, so a 
search on “Seattle” returns the city name as a genre that 
encompasses a variety of Seattle-area terrestrial stations, 
broadcasts related to the Seattle Mariners baseball team and 
the Seattle Seahawks football team, Internet radio stations 
with the word “Seattle” in their titles, and even individual 
show episodes that include “Seattle.”

Unsure what to search for? You can browse TuneIn’s 
content in the toolbar at the top of the page, split into categories like Local, Music, Sports, News, and Talk. You can also browse stations by location, 
if you want to scan for interesting stations from Australia, for instance.

TuneIn isn’t limited to radio, as it also hosts Pandora-like artist stations, podcasts, and, if you sign up for TuneIn Premium, audiobooks. More 
on that shortly.

To play anything in the search results, hover over the album art 
icon, which causes it to morph into a play button. Clicking the 
name of the entry reveals additional details, such as broadcast 

schedules for particular programs. Some talk radio shows list not only live 
broadcasts but also past episodes.

Whenever you’re playing an audio stream, a toolbar with playback controls 
appears at the bottom of the page. You can even keep browsing without stopping 
playback. One nice touch is that you can pause a live broadcast and later pick up 
where you left off. I’m not sure how long you can pause live radio, but I have 
paused a program overnight and returned to it the next day with no issues. As 
with all methods of playing Internet radio stations, the quality can vary; I doubt 

TuneIn has any control over the 
streaming software or upstream 
bandwidth used by the radio stations to 

which it provides access.
The free TuneIn Radio app works similarly to TuneIn’s Web site but is focused more on browsing than on search. The first tab, Home, displays a 

number of stations split into categories. Nonetheless, the Search tab lets you search for whatever you want. For those in Apple’s platform ecosystem, 
the TuneIn Radio app offers an Apple Watch app and CarPlay integration, though no Apple TV app. A separate $9.99 TuneIn Radio Pro app 
eliminates banner ads and gives you the option to record what you’re listening to and listen to it later offline, although only within the app itself. 
TuneIn also makes a version of its app for Android.

http://tunein.com/premium/
http://tunein.com/premium/
https://itunes.apple.com/us/app/tunein-radio-pro-stream-mlb/id319295332?mt=8&at=10l5PW
https://itunes.apple.com/us/app/tunein-radio-pro-stream-mlb/id319295332?mt=8&at=10l5PW


17
Basic use of TuneIn is free, supported by audio ads that play whenever 

you first start playing and banner ads in the free mobile apps. Note that 
commercial stations broadcasting over TuneIn play their own ads, in 
addition to those TuneIn adds. TuneIn’s additional audio ads aren’t 
terribly intrusive, perhaps because we’re all used to hearing them on the 
radio, and they don’t play that often.

However, paying $7.99 per month gets you TuneIn Premium, which 
removes banner ads from the mobile apps and adds over 600 
commercial-free radio stations, a collection of 40,000 audiobooks, and 
live games from sports stations from Major League Baseball, the National 
Basketball Association, the National Football League, and Barclays 
Premier League (soccer). TuneIn Premium also offers some 
language-learning stations.

If you’re a sports fan, TuneIn Premium may be tempting, but you 
may not have to pay to listen to sports. ESPN Radio is a free station, and 
many stations may have live broadcasts of their local sporting events.

TuneIn’s audiobook collection is a bit more exciting, especially since 
TuneIn Premium is just over half the cost of a standard $14.95 per 
month Audible subscription. The selection seems to be good. At a glance, 
I spotted all of George R.R. Martin’s “A Song of Ice and Fire” series, Suzanne Collins’s “The Hunger Games” series, much of Stephen King’s “The 
Dark Tower,” Aziz Ansari’s “Modern Romance,” Lois Lowry’s “The Giver,” Max Brooks’s “World War Z,” Ernest Cline’s “Ready Player One,” 
and Amy Poehler’s “Yes Please.”

The potentially significant downside to using TuneIn for audiobooks is that it works only in a streaming mode. That may be acceptable if you 
listen while on Wi-Fi or if you have an unlimited data plan and solid cellular connectivity, but for most people, the combination of spotty cellular 
connectivity and data overage fees will weigh against TuneIn audiobook accompaniment on long road trips.

In sum, TuneIn is perfect for those who don’t want to lose touch with a hometown or college radio station, and for people who want to explore 
music via Internet radio rather than through a free Spotify subscription. It might be a good solution for staying up with a favorite sports team in 
another location, but your level of success will vary with the sport and the team. For high-profile American sports and English soccer, a TuneIn 
Premium subscription could be worthwhile if you can’t find a free alternative, but the service’s lack of offline capabilities render the audiobook 
subscription less appealing.

http://tunein.com/premium/
http://tunein.com/premium/
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Cropping and Resizing Images
by Adam C. Engst  and Josh Centers

In “The Power of Preview: Pulling Files into Preview” (25 February 2016) and “The Power of Preview: Viewing Images and PDFs” (13 
March 2016), we walked you through the basics of opening and viewing files in Preview, OS X’s venerable, all-purpose document and image viewer. 
This time, we begin digging into Preview’s image manipulation capabilities.

As writers of technical articles and books, we work with screenshots constantly, and Preview saves us time over using more full-featured tools like 
Pixelmator or Photoshop, thanks to Preview’s focused tool set. You can even take screenshots from within Preview itself, as noted in “The Power of 
Preview: Pulling Files into Preview”.

The most common tasks we perform when editing screenshots are cropping and resizing, to cut out unneeded elements and keep images from 
being too large. Preview excels at both of these tasks.

Cropping Images with Preview -- To crop an image means to remove everything outside of a selected area, and Preview makes that easy. But 
first, you have to understand how to use its Rectangular Selection tool.

The Rectangular Selection tool should be the default when viewing images, but if you need to activate it, choose Tools > Rectangular Selection. It’s 
also available on the far left of the Markup Toolbar, which you can display by choosing View > Show Markup Toolbar (Command-Shift-A).

Using the Rectangular Selection tool is simple: just click and drag to 
create a selection box. You can move the selection box by positioning your 
cursor inside the box so it becomes a hand — after that, click and drag to 
move the box. Likewise, you can click and drag the blue circles to adjust 
the size of the box. As you adjust the size of the box, its pixel dimensions 
are displayed in a small popover, a handy aid.

  In the example screenshot, we want to crop out everything but the 
Finder and Preview windows. Once the selection box is over the windows, 
select Tools > Crop (Command-K) to cut out everything that’s not 
wanted.

  That’s not hard, but here’s a technique that simplifies creating 
precise crops around windows, dialogs, and other objects.
First, don’t attempt to make a precise selection, since that can be 
tricky. Instead, drag out a rough selection around the desired object 
that includes some of the background, and then press 
Command-K to make an initial crop.
  Then use the blue handles in the middle of each side of the 
selection rectangle to move each side in to exactly the desired 
position before cropping again. That requires four actions, but can 
be more precise than using the corner handles, which resize the 
selection in two dimensions at once. It can be hard to get both 

sides exactly right at the same time.
If you’re cropping a very small object, such as the buttons we use as inline graphics in Take Control books, after making that initial rough crop, 

zoom in closely so you can see the object’s exact edges before dragging the side handles in to make your final selection and then cropping. For 
zooming instructions, refer back to “The Power of Preview: Viewing Images and PDFs.”

Here’s a final tip to remind you of a feature we mentioned in “The Power of Preview: Pulling Files into Preview.” If you make a rectangular 
selection, instead of cropping, you can copy the selection and then choose File > New from Clipboard to create a new document containing the 
copied data. In other words, a selection followed by Command-C and Command-N is a quick way to get a new file containing your desired content 
— it’s another path to a cropped image that might be more appropriate in certain workflows.

The Power of Preview

http://tidbits.com/article/16284
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We’ve focused on images here, but you can also crop PDFs using the same method. This is rarely useful, and note that Preview crops only a single 

page at a time. Plus, since Preview doesn’t actually delete content, but instead just hides it, the PDF will likely appear uncropped in other apps. 
Preview even warns you of this fact.

Resizing Images with Preview -- You’ve cropped out the parts of the image you don’t need, but it’s still too large, either in terms of dimensions 
or file size? Again, Preview makes it easy to shrink the image.

Choose Tools > Adjust Size and a handy dialog appears. Play with the settings and 
either click OK to apply your changes or Cancel to back out. Here’s a quick 
overview of what each of the controls does:
• Fit Into: This dropdown menu gives you a set of predefined sizes to fit the image 

into. These sizes match common screen sizes, and are most useful for making 
wallpaper images. If your image doesn’t match the aspect ratio of the pre-defined 
size you choose, Preview fits the longest side of your image to the appropriate 
dimension. So a portrait image will always be fit to the height of the pre-defined 
size, and landscape images will be fit to the width. When you adjust the width and 
height yourself, this menu sets itself to Custom; you don’t need to choose that 
manually.

• Width and Height: In these fields, you can manually set the width and height of 
the image. The pop-up menu on the right lets you set the unit of measurement: 
pixels, percent, inches, centimeters, millimeters, or points. Which of these you 
choose depends mostly on how you think about your output.

• If you’re planning to use the image on a Web site, pixels likely makes the most 
sense, whereas if it’s destined for a printed document, a real-world measurement 
like inches, centimeters, or millimeters may be more helpful. If the actual size doesn’t matter too much, you can shrink it by a percentage.

• One tip that applies to all image editing: you can always scale images down, but you don’t want to scale images up. Unlike what you may see on 
TV shows, scaling an image up almost never works well, because Preview has to generate pixels out of thin air, and the resulting image is always 
blurry.

• Resolution: Here you can adjust the resolution of the image, in either pixels per inch or pixels per centimeter. Resolution is a tricky topic, but in 
short, for images destined for the screen, it’s usually irrelevant and can be ignored. For screen display, all you care about is how many pixels the 
image has — whether it’s 72 ppi or 144 ppi should make no difference in how it looks onscreen. Don’t assume that reducing the resolution will 
make the file size smaller either; it will if you select Resample Image because you’re throwing away pixels, but if you don’t resample the image, the 
file size will stay roughly the same and may even increase somewhat for JPEGs.

• For images you want to print, resolution is important to know. If you have a 72 ppi image, it will need a lot more pixels to print at a decent size on 
paper than if it’s a 300 ppi image. But you can’t change the resolution to get better results because any change in resolution must either throw 
pixels away or add pixels in, neither of which is good for the image. In short, unless you know what you’re doing, leave the resolution setting alone. 
For a good discussion of resolution, see the Photoshop Essentials site’s explanation.

• Scale Proportionally: In nearly all cases, leave Scale Proportionally selected, because otherwise your image will be stretched or squished in the 
dimensions that change.

• Resample Image: As noted above, resampling changes the number of pixels in the image. Thus, it should be selected in most situations, 
particularly when the image is destined to be displayed on a screen, where you want to control the pixel dimensions. And in fact, if you deselect 
Resample Image, you can no longer choose pixels in the pop-up menu next to Width and Height, Scale Proportionally is locked on (since 
disproportionate scaling would change the number of pixels), and any changes you make in Width and Height also change Resolution. All you 
can do then is change how large the image will print. Again, Photoshop Essentials has a nice explanation.

• Resulting Size: This feedback area is useful to watch, particularly if you’re trying to reduce the file size of your image. As you adjust the image’s 
pixel dimensions, it tells you the resulting percentage size of the original image, the resulting file size, and the previous file size. Changing resolution 
while resampling doesn’t affect size much, and Preview doesn’t report on such changes.
It’s extremely easy to get confused when playing with image size settings because Preview honors the physical dimensions (which are based in part 

on resolution) when displaying images and attempts to open all images at actual size. In our discussion of Preview’s preferences in “The Power of 
Preview: Viewing Images and PDFs,” we said that we had no idea why you’d choose between 1 Image Pixel Equals 1 Screen Pixel and Size on 
Screen Equals Size on Printout for Define 100% Scale As. Now we understand. When you see “100%,” think “Actual Size.”

If you’re working with images primarily for display on screen, such as on Web pages, it’s probably most sensible to choose 1 Image Pixel Equals 1 
Screen Pixel. That way, if you open a 1920-by-1280 image that’s 300 ppi, Preview displays it at its actual size in pixels. A 1920-by-1280 image that’s 
only 72 ppi opens at exactly the same size. That’s what you’d expect, since resolution isn’t relevant to publishing on screen.

http://www.photoshopessentials.com/essentials/image-resolution/
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However, if most of your image work is destined for print, selecting Screen Equals Size on Printout may be helpful, since then, assuming the same 

pixel dimensions, a higher-resolution image appears smaller and a lower-resolution image appears larger, just as would happen on a printout. In that 
case, Preview displays the 300 ppi image at a much smaller size than the 72 ppi image when both are at actual size.

The problem with Preview honoring the resolution-dependent physical dimensions is that other graphics programs, like Graphic Converter, focus 
only on pixel dimensions. If you work in other graphics apps too, Preview may confuse you by displaying the same image differently. So don’t get 
too wrapped up in how something looks in Preview; just focus on the pixel dimensions for screen-destined images.

Undoing It All -- The safest approach when editing an image is to make a copy before modifying it, but it’s easy to forget to do that. In that case, 
you have two ways to undo unwanted changes.

The first is the hoary Edit > Undo (Command-Z) command, which lets you undo recent actions. There’s also Edit > Redo (Command-Shift-Z), 
which lets you redo actions that you’ve undone. Nothing new there.

But if you’ve already saved and closed a file, and later reopened it, you can’t use the Undo command. Thankfully, you can still revert to an older 
version, thanks to Preview’s support for the Modern Document Model (see “The Very Model of a Modern Mountain Lion Document,” 7 August 
2012). Choose File > Revert To, where you see two options: Last Opened and Browse All Versions. Last Opened reverts all changes made to the file 
since you last opened it.

Browse All Versions displays a Time 
Machine-like interface, with the 
current version of the document on the 
left and previous versions on the right. 
Use the arrow buttons to move 
between versions — unfortunately, it’s 
usually impossible to discern the 
differences between versions that have 
just been resized, so you may have to 
guess based on the timestamp. Click 
Restore to restore the file to the version 
showing on the right, or click Done to 
cancel.

We’ve barely touched the modifications you can make to documents and images in Preview, but this article lays the groundwork for future 
exploration. You now understand how to select parts of a file and undo unwanted changes. Next, we’ll dig deeper into Preview’s image-editing 
power.

http://tidbits.com/article/13187
http://tidbits.com/article/13187
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Reviews
Folx Pro 5

by L. Davenport

Have you ever had a large file that took so long to download that you could go get a cup of coffee, brush your teeth, etc. and still sit in front of your 
computer waiting for the download to complete? Well then you might want to give Folx Pro a test-run. Folx Pro is three programs in one. It is a 
download manager, a Torrent client, and a YouTube 
video downloader.

Folxs comes in two versions - a free limited features 
version and a Pro version. This review will cover the Pro 
version.

Download Manager
There are two ways that you can have Folx download 

your file. The first way is by using the Folx program 
itself. You simply copy a URL from your browser and 
click on the “+” button at the top of the Folx window. 
As soon as the download window opens, the URL that 
you copied is automatically placed in its search field.

You can have Folx immediately download the file or  
you can set a few preferences that will speed up the 
download and tell it where to download to. The options 
are:
• Tags: You can assign one or multiple Tags to the file you want to download, 

e.g if it is a movie, application, etc. Folx will use the tags to sort the downloads 
in Tags panel.

• Save to: You can choose the location for the download or you set it to 
“Automatic” which tells Folx to save it to the location that is pre-configured 
for the chosen Tag that you assigned the file. 

• Start: You can have the file downloaded immediately or schedule a specific 
time for the download.

• Split into: This is the most important setting. You can tell Folx to split your file 
from 2 to 10 threads for a quicker download than the standard single thread.

• Rename: You can rename the download file.
• Referrer: The referrer is an HTTP header field that identifies the address of the 

webpage that linked to the resource being requested. Some of the websites you 
download from may require the referrer URL to be present.

• Description: You can write a short description for your file. Once downloaded, the 
file will become searchable by this description in Spotlight.

• Authentication: You can specify the login and password if the server you are 
downloading from requires them.

• Set as default: You can have Folx remember the current settings so these settings will 
be automatically applied the next time you add a task.
Once all of the selections (that you want to set) are complete, you simply click the 

OK button and your file starts downloading (or waits for the scheduled download 
time).

Folx has a Speed control option that lets you control the downloading speed by 

Folx Pro can split your file up to 10 threads for a quicker 
download than the standard single thread.

The optional Folx browser extension lets you add your 
downloads directly to Folx from your Safari, Chrome, 

Firefox, or Opera browser.
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either adjusting it manually or allowing Folx to do that automatically for optimal 
traffic allocation.

Folx comes with an iTunes integration option. This means you can have all of the 
music and videos that you download with Folx automatically go to iTunes playlists.

A nice added benefit from using Folx is the ability to stop and restart a download 
(whether you stopped the download yourself or if the power went off and the Internet 
connection was severed). This is very helpful when you are downloading a large file. 
You don’t have to loose time by having to restart the download from the beginning.

If you want to have the speed of Folx right from your browser, you can download 
the optional Folx browser extension. The supported browsers are: Safari, Chrome, 
Firefox, and Opera.

After the extension is installed, Folx will intercept any download 
commands you make in your browser and then download the file 
itself. You can even download multiple files by right-clicking on the 
URL links and selecting “Download the selected with Folx” option 
found in the resulting contextual menu. Alternately, you can set a 
Services Preference to have a “Download with Folx” always appear in 
the Services menu.

Torrent Client
The second part of Folx is the Torrent Client. You can search for 

torrents and download them directly from Folx’s interface. You don't 
need to manually browse through multiple torrent trackers to find 
what you need anymore. Instead, you can enter a keyword in Folx, 
and it will search for it in its extensive list of torrent trackers and 
display a list of relevant results.

In addition to downloading files from torrent trackers, Folx enables you to download using 
magnet links. This means you do not have to save a separate file before starting the actual download, 
which is convenient. 

FYI: While you are downloading a Torrent file, your computer becomes another peer on the 
network, and as such, your computer may end up hosting one of the chunks of the final file, and is 
available to all the other peers as a source of that data as long as your BitTorrent client is still running.

YouTube downloader
You can use Folx to download videos from YouTube. If the video allows it, you can select the 

quality of the video (from mp4 144p up to mp4 1080p). It also gives you the option to download 
only the video’s soundtrack.

As with the other parts of Folx Pro, downloads can be performed immediately or scheduled for a 
later time.

Disclaimer: Neither L. Davenport nor SMMUG is endorsing downloading online videos. This review is only telling you the 
capabilities of the Folx Pro program.

The Skinny
Evaluation: I tested downloading a file using Safari and then Folx Pro. I am happy to say the Folx download was a lot faster when I set it to split into 
10 threads. I really don’t download Torrent files, so I can’t say if this is any better than the others out there. But if you do download Torrent files, this 
could be a nice tool for you. Finally, the ability to download videos from YouTube is a real plus (for those who want to do this). 
Requires: OS X 10.9 or higher, 29.86 free hard drive space
Company: Eltima Software
Price: $19.95 or free for the limited feature version. Migration discount: Registered users of Speed Download 5, Speed Download Lite, Leech, or 
iGetter, can get the Folx Pro version with a 50% discount.
Available Trial copy

You can have Folx down multiple files at one time.

You can use Folx’s Torrent tab to download torrent files (left image). Folx 
comes with a list of torrent trackers that it will  use when it searches for 

your torrent file (right image).

Folx can download YouTube files. It also 
gives you the option to select the quality of 

the video to be downloaded or choose to 
download only the video’s audio.

http://mac.eltima.com/download-manager.html
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BitTorrent Live Brings a Weird Selection of Free Content to Apple TV -- The BitTorrent Live app offers some obscure cable channels to Apple 
TV owners, for free. While the selection is truly odd, there’s a little something for everyone.

Amazon Playing Hardball on Apple TV App -- Even though Amazon has previously hinted at making a Prime Video app for the Apple TV, 
don’t hold your breath for it to appear anytime soon. When asked at this year’s Code Conference why Amazon doesn’t sell streaming media boxes 
from Apple and Google, Amazon CEO Jeff Bezos said, “When we sell [streaming] devices, we want our player — our Prime Video player — to be 
on the device, and we want it to be on the device with acceptable business terms.” As many have suspected, there appears to be some concession 
Amazon wants from Apple before releasing an Apple TV app. What that could be is unknown; Apple does require a 30 percent cut of sales made 
through apps, but Amazon could easily circumvent that by requiring users to sign up for Amazon Prime outside the app.

Spotify Updates Family Plan to Match Apple Music -- Streaming music service Spotify is now cheaper for families, matching Apple Music in 
both price and number of family members. The Spotify family plan now covers up to six people for one monthly $14.99 fee. Previously, $14.99 
included only two members, though you could pay $5 extra for each additional person up to a maximum of five. Spotify’s new plan is thus no 
different for two-person families, but could be more than half off for a household of six. As a bonus, Spotify families aren’t locked together in a 
Family Sharing group, as is the case with Apple Music.

Apple Investigating iPad “Error 56” Problems with iOS 9.3.2 -- Over at iMore, Rene Ritchie has passed along a statement from Apple that the 
company is “looking into a small number of reports that some iPad units are receiving an error when updating the software.” According to an Apple 
support document, Error 56 might indicate a hardware issue, but Apple recommends first trying to restore the device with iTunes and then 
contacting Apple support if that doesn’t help.

Apple Union Square Previews the Future of the Apple Store -- Angela Ahrendts, Apple’s SVP of Retail and Online Stores, and Chief Design 
Officer Jonathan Ive have unveiled Apple’s new flagship store in San Francisco’s Union Square. Highlights of Apple Union Square include expansive 
exterior windows, interior greenery, free Wi-Fi in an outdoor public plaza, a 6K video wall, and private rooms for business training. Apple is hoping 
to turn the Apple Store into a community hub, with game nights with App Store editors, “creative sessions” with local artists, and live music acts. 
Apple says that many of these features will also be coming to an Apple Store near you. iMore has pictures and video.

117 Million LinkedIn Passwords Leaked -- LinkedIn was infiltrated back in 2012, but the repercussions are still being felt, with a collection of 117 
million user email addresses and passwords from that breach released online recently. LinkedIn is reaching out to all affected users, but even if you 
don’t hear from the company, we recommend taking the opportunity to check your password and change it if you’ve used it on any other sites or if 
it’s not a strong password. We realize that we sound like a broken record here (there’s an analogy on its way out!), but this is yet another reminder of 
why it’s so important to have unique, strong passwords for every online account.

Warren Buffett Invests $1 Billion in Apple -- After Apple’s first year-over-year quarterly revenue decline in 13 years, some on Wall Street soured 
on the company’s stock, but one big-name investor is betting heavily on Apple. Warren Buffett’s Berkshire Hathaway firm invested over $1 billion 
in Apple earlier in 2016. Berkshire Hathaway is famously conservative in its investments, and rarely ventures into the tech sector, so its backing is a 
vote of confidence in Apple during an uncertain time. News of Berkshire Hathaway’s stake in the company caused an immediate 3.7 percent 
increase in Apple’s stock price.

CurrentC Out of Juice -- The Verge is reporting that MCX, the retail consortium behind Apple Pay competitor CurrentC, is laying off 30 
employees. The layoffs may indicate that CurrentC, which never saw widespread release, is dead in the water. Since MCX-affiliated merchants 
banded together to block Apple Pay in October 2014, some members, such as Best Buy, have added support for Apple Pay, while others, like 
Walmart, have introduced their own payment apps. This outcome was entirely predictable: CurrentC linked to customer checking accounts via 
flimsy QR codes, giving it the double whammy of being both inconvenient and insecure.

With Gboard, Google Unveils a Great iPhone Keyboard -- It has taken almost two years for a great iOS keyboard to appear, but Google has 
done it with Gboard, which integrates Google search, glide typing, easy emoji entry, and other neat features into a well-made keyboard.
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Procreate for Cartooning on the iPad Pro -- Our resident bad cartoonist draws upon the power of Procreate to unleash his creativity with the iPad 
Pro and Apple Pencil.

The iPhone SE: A Modern iPhone in a Classic Case -- Long after adapting to phablet-sized iPhones, Julio Ojeda-Zapata revisits a classic design in 
the form of the iPhone SE, which looks like the iPhone 5s but has up-to-date internals. He found much to like (and a bit to dislike) about Apple’s 
new handset.

The Right to Bear… Encryption? -- The Second Amendment to the U.S. Constitution is a favorite of gun owners, but could it also provide a 
constitutional basis for a right to encryption? That’s not as kooky as it sounds. As Motherboard’s Susan McGregor explains, the United States 
government has long considered encryption to be “munitions,” as was the case for Philip Zimmermann, developer of the PGP cryptographic 
software, when he was detained at Dulles International Airport in 1994. But if the Second Amendment guarantees Americans the right to own 
firearms, it might also support our right to use encryption. However, that line of reasoning opens up a family-sized can of worms. For instance, could 
convicted felons be barred from using encryption? Furthermore, many privacy advocates may not be thrilled to find themselves on the same side of 
the table as the gun lobby.

Google Flights Offers a Slick Travel Planning Interface -- If you haven’t used Google Flights when looking for inexpensive airfares, give it a try. 
Adam Engst took it for a spin and found its interface fast, efficient, and elegant.

Apple at a Crossroads with Podcasting -- More than a decade after Apple officially started supporting podcasts in iTunes, they are booming in 
popularity. In that time, however, little about how Apple manages the popular iTunes podcast directory has changed, which has some podcasters 
concerned. The New York Times reports that complaints include having to woo a single Apple employee in charge of promoting podcasts, not 
receiving enough listener data, and the difficulty of sharing podcast episodes to social media. As Google and Spotify add podcasts to their music 
subscription services, providing extra perks for podcasters, Apple may be considering changes, based in part on talks held with leading podcasters in a 
Cupertino meeting in April.

Marco Arment to Podcasters: “Be Careful What You Wish For” -- Podcast-client developer and podcaster Marco Arment has penned a response 
to the New York Times article about Apple’s tepid support for podcasting, warning podcasters to be careful what they wish for. Arment calls the 
New York Times article “ill-informed” and cautions that many of the suggestions therein could damage the podcasting medium. He warns that 
providing the listener data that some large podcasters want could make podcasting as intrusive and annoying as the Web, and he says that giving 
Apple more power over shows and revenue would have negative consequences. “It would not only add rules, restrictions, delays, and big 
commissions, but it would increase Apple’s dominant role in podcasts, push out diversity, give Apple far more control than before, and potentially 
destroy one of the Web’s last open media ecosystems.”

Dish Now Offering iPhone House Calls -- Satellite provider Dish has an intriguing new service: on-site iPhone screen and battery repair. You’ll 
pay a premium for its services, which range from $74.99 to $184.99. That’s more than even Apple typically charges, but it might be worthwhile if 
you don’t have an Apple Store or Apple Authorized Service Provider nearby. $35 of the fee is a “Drive to Me” fee, which Dish waives for additional 
devices repaired in a single visit. While Apple’s original warranties won’t cover devices fixed by Dish, Dish warranties its work for 60 days.

How Steve Jobs Inspired the Apple Watch -- You could ascribe Apple’s development of the Apple Watch to any number of commercial or even 
cynical reasons, but the one cited by Apple executives is the late CEO Steve Jobs’s vision of making the company’s customers healthier through 
technology. According to Tim Bajarin in Time, after Jobs was diagnosed with pancreatic cancer in 2004, he grew frustrated with the byzantine 
American medical system and became obsessed with bringing digital order to healthcare data. Although it’s unclear if Jobs knew about the project, 
his desire to improve healthcare inspired Apple to create the Apple Watch, in part as a platform for health monitoring. Along the way, the company 
has also started to make a real difference in the healthcare field with initiatives like HealthKit, ResearchKit, and CareKit.

Reuse governed by Creative Commons license. TidBITS has offered years of thoughtful commentary on Apple and Internet 
topics. For free email subscriptions and access to the entire TidBITS archive, visit www.tidbits.com.
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HOW TO FIND US
General meeting:
SMMUG General Meetings are held on the SECOND Monday of 
each month at Fire Station 14 located at 1875 Dublin Blvd (at the 
intersection of North Academy and Dublin). 

Directions:
From Academy, go east on Dublin and then turn right on 
the very first street. There is parking on the west and south 
sides of the Fire Station (with additional parking located to 
the north and further west of the Fire Station). The entrance 
is on the west side of the building.

Smoking is not permitted on the premises. 

Sig meeting:
The SIG Meetings are held on the SECOND Saturday of each month at Fire Station #18’s meeting room - located at: 6830 Hadler View 
[the fire station is behind Walgreens]. 

Directions:
#1) Take I-25 to Garden of the Gods Rd (head west), turn right on Centennial, left on Flying W Ranch Rd., right on Hadler View.
#2) (This route is bumpier and probably not the best for winter travel) Take I-25 to E. Woodman/W. Rockrimmon Blvd., turn right on Vindicator 
(at the Safeway intersection), and then right on Hadler View.
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Membership Application Form
Membership entitles you to access to our online forums, participation in prize drawings, and access to the 
bargains in the members area of the SMMUG website at www. smmug.org. SMMUG renewal membership dues 
($25) apply to the calendar year and are paid each December for the following year. Use the following table for 
NEW MEMBERSHIP ONLY:

 JAN 1 to MAR 31 - $25.00  APR 1 to JUN 30 - $21.00
 JUL 1 to SEPT 30 - $14.00  OCT 1 to DEC 31 - $7.00

Please Print Clearly!     Today’s Date 

Name
 Street Address

 City/State/ZIP
 Home Telephone

 E-mail Address
Have you previously been a member of SMMUG?
How did you learn about SMMUG?

Make your check payable to:  SMMUG  
Then mail or give this form and your check to:

SMMUG, Inc. 
Skip Mundy, Treasurer   
PO Box 62741 
Colorado Springs, CO   80962 

Please make an online account for me.
User Name _______________

Don’t make an online account for me. 
I do not want one or I already have 

Business Telephone 

About Us

The Silicon Mountain Macintosh User Group, Inc. (a nonprofit educational corporation) was formed in Colorado Springs, 
Colorado in 1985, and is one of the oldest Macintosh User Groups in the United States. SMMUG, Inc. is dedicated to helping 
members enjoy and learn about their Macintosh computer, iPhone and iPad devices.

Club membership is open to everyone and you are cordially invited to visit our free monthly General Meeting on the second 
Monday of each month, at 7:00 PM. For those new to the Macintosh, we have a Question & Answer session at 6:00 PM, where 
our collective expertise can help answer your questions. 

All members receive a monthly newsletter, published on our web site, see great reviews of software and hardware, or can 
participate in the monthly door prize drawing. Each member gets one vote during annual Officer Elections. No corporate 
memberships are granted.

Our officers are volunteers and receive no pay. All funds raised are used for the cost of operating the club and its meetings.

http://www.smmug.org
http://www.smmug.org

